Design and Modeling
**Student Accessibility**

In addition to the student accessibility standards inherent in the way we develop PLTW courses, PLTW supports purposeful student accessibility in the following ways:

Courses supports standard accessibility practices and techniques including the use of video captions, alternative text descriptions, and compatibility with screen readers. (Note: Features may vary based on course development date.) Some of our newer PLTW course developments feature a Student Accommodation section to help support you in adjusting course activities, projects, or problems to be accessible for your students. A non-digital, PDF version of the student course curriculum is available for use in the following classroom situations:

**Technology issues.**

Students who require a text or print version.

Another circumstance in which student access to digital course curriculum is not feasible or possible.

These course versions are intended to be used only to support student accessibility when access to digital content through Courses is not possible.

**Important:** Due to its non-digital nature, the PDF version of course curriculum will not feature digital interactivity and tools, embedded media, or any updates made available via Courses during the school year.

---

**Video resources**

---

Copyright © 2017 Project Lead The Way, Inc. All rights reserved.
Table of Contents

1. Design and Modeling
   1. Landing Page
      1. General Student Resources
      2. Copyright Notice
         1. It is illegal to make copies of this course without the permission of Project Lead The Way, Inc.
   2. Lesson 1: Introduction to Design
      1. Activity 1.1: Foot Orthosis Instant Design Challenge
         1. Procedure
            1. Part 1: Design an Ankle Foot Orthosis
            2. Part 2: Reflect
            3. Part 3: Design Process
            4. Part 4: Introduction to the Problem
      2. Activity 1.1: Design Process Reflection Table
      3. Activity 1.1 Rubric
   2. Activity 1.2: A Picture Is Worth a Thousand Words
      1. Procedure
         1. Part 1: Thumbnail Sketch
         2. Part 2: Isometric Sketch
         3. Part 3: Multiview Sketch
         4. Part 4: Mystery Object (Optional)
      2. Activity 1.2: Sketching Reference
         1. Thumbnail Sketching
         2. Sketching Line Types
         3. Isometric Sketching
         4. Multiview Sketching
      3. Activity 1.3: How Big Was That Fish?
         1. Procedure
            1. Part 1: Measuring
            2. Part 2: Dimensioning
            3. Part 3: Surface Area and Volume
      4. Project 1.4: Investigate the Inside
         1. Procedure
            1. Part 1: Dissect and Document
            2. Part 2: Sketch with Dimensions
            3. Part 3: Design Modifications
            4. Part 4: Decision Matrix and Presentation
      2. Project 1.4 Rubric
   3. Lesson 2: Modeling and Statistical Analysis
      1. Activity 2.1: Building Blocks
         1. Procedure
            1. Part 1: Define the Problem
            2. Part 2: Generate Concepts
            3. Part 3: Design a Solution
            4. Part 4: Explore Coordinate Planes and Shapes
            5. Part 5: Investigate Solid Shapes
            6. Part 6: Solid Modeling
            7. Part 7: Using Nets (Optional)
2. **Puzzle Design Challenge Brief**
   1. **Problem Statement**
   2. **Design Statement**
   3. **Criteria and Constraints**
   4. **Deliverables**

2. **Activity 2.2: Taking Modeling to Another Dimension**
   1. **Procedure**
      1. **Part 1: Geometric Primitives and Measurement**
      2. **Part 2: Creating Models with Additive and Subtractive Methods**
      3. **Part 3: Creating Puzzle Cube Parts**
      4. **Part 4: Designing with Surface Area and Volume Constraints**

3. **Project 2.3: Puzzle Cube Statistical Analysis**
   1. **Procedure**
      1. **Part 1: Solid Modeling and Prototyping**
      2. **Part 2: Testing**

2. **Puzzle Cube Data Sheet**

4. **Lesson 3: Design Challenge**
   1. **Activity 3.1: Let's Simulate to Elucidate**
      1. **Procedure**
         1. **Part 1: Computational Solutions**
         2. **Part 2: Using OpenSim for Gait Analysis**
         3. **Part 3: Using OpenSim for Wrist Analysis**

   2. **Problem 3.2: Therapeutic Toy Design**
      1. **Procedure**
         1. **Part 1: Define the Problem**
         2. **Part 2: Generate Concepts**
         3. **Part 3: Design a Solution**
         4. **Part 4: Build and Test**
         5. **Part 5: Evaluate the Solution**
         6. **Part 6: Present the Solution**

   2. **Problem 3.2 Rubric**

3. **Problem Design Brief Template**
   1. **Problem Statement**
   2. **Design Statement**
   3. **Criteria and Constraints**
   4. **Deliverables**

4. **Decision Matrix Template**

5. **Design Brief Reference Guide**
   1. Use the explanations shown to guide you to create your own Design Brief.

5. **Appendix**
   1. **Remarks**
   2. **Glossary**
Lesson 1: Introduction to Design

Preface

The goal of this lesson is to introduce you to the design process and skills essential to design and modeling.

Essential Questions

1. How is a design process used to effectively develop a design solution that solves a problem or addresses a design opportunity?
2. What role do team norms play in making a collaborative team more successful?
3. Why is accurate measurement, precise dimensioning, and thorough documenting necessary for both mechanical dissection and creative problem solving?

Lesson 2: Modeling and Statistical Analysis

Preface

The goal of this lesson is to develop your design and modeling skills and introduce you to various types of modeling techniques used by engineers and scientists.
Essential Questions

1. Why is it important for an engineer to be aware of the criteria and the constraints when designing a project?
2. How can mathematical modeling help designers understand a design?
3. How can computational thinking be applied when developing an engineering solution?
4. How is design testing data used to improve design solutions?

Lesson 3: Design Challenge

Preface

The goal of this lesson is to apply the knowledge and skills that you have acquired in the Design and Modeling unit, as you design and fabricate a therapeutic toy for children with cerebral palsy.

Essential Questions

1. How are modeling and simulation used in various professions?
2. Why are teams of people more successful than an individual when solving problems?
3. Why is brainstorming, research, and testing important when creating, modifying, or improving a design solution?
General Student Resources

PLTW Gateway Notebook, Binder, Portfolio

- PLTW Gateway Notebook, Portfolio and Binder Description
- Portfolios Presentation
- PLTW Gateway Notebook Templates
- PLTW Gateway Notebook Sample Entries
- Isometric Graph Paper
- Orthographic Graph Paper
- Gateway Classroom Binder Dividers
- PLTW Gateway Notebook Additional Resources Download

Formula Sheet

- PLTW Gateway Formula Sheet
- Abbreviations of Common Units and Metric Prefixes

design process

- Design Process Overview
- Design Process Solution Template
- Design Brief Template
- Design Brief Example
- PLTW Gateway Notebook, Classroom Binder, and Portfolio Description
- Decision Matrix Template
- Rubric PLTW Gateway Notebook

research
Working with Experts and Mentors

Written Report Format

Presentation Rationale

Citations APA Style

rubrics

Peer Rubric

Presentation Rubric

Project Report Rubric

Student Reflection On Project Rubric

Written Report Rubric

PLTW Gateway Notebook Rubric
Copyright Notice

It is illegal to make copies of this course without the permission of Project Lead The Way, Inc.

All software, courseware, images and material contained in this course are the property of Project Lead The Way, Inc., unless otherwise provided, and are protected under Federal copyright law. It is illegal to make and/or distribute any of the contents of this course without the permission of Project Lead The Way, Inc. The use of this course and its contents is for the PLTW Program, by its network of educational institutions, schools, teachers and affiliates, in accordance with the terms of their agreements with Project Lead The Way, Inc. Duplication or other use of this file without proper authorization may be against Federal law, and may subject you to monetary and other penalties.

If you have questions about the proper use of PLTW materials or to report copyright violations, please contact:

Project Lead The Way, Inc.
3939 Priority Way South Drive, Suite 400
Indianapolis, IN 46240
Toll Free: 877-335-PLTW (7589)
Local: 317-669-0200 Fax: 317-663-8296
Email: solutioncenter@pltw.org
Foot Orthosis Instant Design Challenge

Introduction

There are many ways to solve a problem. Sometimes solving a problem is simple and fast, and other times it is complex and takes years to develop a solution. For engineers, it is helpful to use a specific set of steps to find the best solution to a problem.

In this activity you will work in a team to solve an instant design challenge. In this challenge you will design, test, and build a model solution for patients with a movement disorder called cerebral palsy. You will put on your designer hats to document and explore the steps you use to solve this problem.

Materials

- Ankle Foot Orthosis Prototype Materials (provided by teacher)
- Design Process Reflection Table
- Instant Design Challenge Rubric
- Gateway notebook

Resources

- Activity 1.1 Design Process Reflection Table
- Activity 1.1 Rubric

Procedure

Part 1: Design an Ankle Foot Orthosis

1. Watch the Instant Design Challenge video.

\[\text{Video: Instant Design Challenge}\]

Refer to your downloadable resources for this video.

2. In a team of four students, use the materials provided to design, build, and test a prototype of an ankle foot orthosis (AFO) for your patient.
   - Review the Instant Design Challenge Rubric with your team before you begin.
   - Decide which team member will be the recorder, model tester, presenter, and team manager.
The recorder is responsible for documenting your team’s process as you work on your solution. This must include information like:
- Team member names and roles
- Questions your team asks
- Steps your team takes as you plan, test, and build your solution
- Any drawings you make
- Any stumbling blocks your team runs into during the process

The model tester is responsible for trying on and testing the model. The model tester will give feedback based on the testing results to make any necessary improvements.

The presenter is responsible for presenting your team’s work and final design solution to the class.

The team manager is responsible for making sure the team works together and all requirements are met, keeping in mind that your team needs to plan, build, and test the solution in the time provided.

Make sure your design meets the following requirements:
- It attaches to the patient’s foot and lower leg.
- It allows upward movement at the ankle, where the foot or toes move in an upward direction toward the shin or front of the leg.
- It places the foot flat on the floor when standing.
- It prevents the patient from pointing or rising up onto their toes.
- It supports the foot and ankle, including the heel and arch of the foot.
- It is comfortable for the patient to wear. Pay special attention to areas where bones may stick out. Too much or too little padding can create pressure points, which can create wounds.
- It is removable.

Make sure to manage your time and materials properly. Remember:
- This is just a prototype, not the final product to be used by your patient.
- You have a limited amount of time. Plan accordingly.
- You have a limited amount of materials. Use them wisely.

3. Informally present your team’s process and model to the class. Make sure to address these questions in your presentation:
- How did you develop your idea (initial conversations and brainstorms)?
- What struggles did you have?
- What changes did you make to improve your design?
- Why do you think your design will satisfy the patient’s needs?

Part 2: Reflect

4. As a group, reflect on your team’s collaboration in the instant design challenge. Discuss each of the following questions and individually record your thoughts in your Gateway Notebook.
- What behaviors positively impacted your team’s effectiveness in designing your team’s solution?
- What behaviors negatively impacted your team’s effectiveness in designing your team’s
solution?
○ How can any negative behaviors be improved next time?

5. Use your reflection to independently define two to three rules for working effectively in a team and record them in your Gateway Notebook. For example:
   ○ We will listen to each other and not interrupt one another.
   ○ We will value the contributions of each team member.
   ○ Each member of the team will be responsible for …

6. Share your rules with your classmates.
7. As a class, pick the top five rules. Going forward, whenever you work in a group, you will use these rules, often called team norms.

Part 3: Design Process

8. Obtain a copy of the Design Process Reflection Table.
9. Watch the Design Process video, and after each step is introduced, pause your video and do the following:

   Video: Design Process

   Refer to your downloadable resources for this video.

   ○ For each step of the design process, work with your team to think about the questions presented below.
   ○ Fill out the Design Process Reflection table to document your reflections.

     ○ **Step 1 – Define a Problem**
       ○ How did you try to further understand the problem when you were working on the instant design challenge? For example, what questions did you ask?
       ○ Were there any questions you should have asked that you didn’t?
       ○ What were the design considerations you had to think about?

     ○ **Step 2 – Generate Concepts**
       ○ How many design ideas did your team consider?
       ○ How did you ensure that everyone on the team contributed their ideas?
       ○ Describe how your team decided which design idea to pursue.

     ○ **Step 3 – Design a Solution**
       ○ How did you communicate your ideas with your team members? For example, did you use drawings?
       ○ Can you think of drawings or models that might have helped you communicate your thoughts better?

     ○ **Step 4 – Build and Test Solution**
       ○ How did you test your solution?
       ○ How did you use what you learned from your testing to modify your design?
       ○ How far back in the design process did you have to go to make any design modifications (picked another solution you had discussed, modified the existing solution, or changed the problem definition)?
Step 5 – Evaluate Solution
- Did you evaluate your solution to make sure it meets the requirements identified in Step 1 – Define a problem?
- How did you test your solution?
- How can your solution be improved?

Step 6 – Present Solution
- How did you share your solution with your classmates?
- What were the artifacts that you shared with your audience?
- How did your audience affect your choice of artifacts to present for your solution?

Part 4: Introduction to the Problem

10. Watch the Problem Introduction video.

Video: Problem Introduction

Refer to your downloadable resources for this video.

11. As a class, discuss your initial reaction to the design problem and share initial ideas for a toy that could help a child with cerebral palsy.

Over the next few weeks, you will learn and practice the skills you need to be ready for the toy design challenge.

Conclusion

1. Describe at least two benefits of using a design process when solving a problem.
2. Describe at least two team norms that are important for teams to work effectively. Discuss how these team norms can positively impact a team’s effectiveness.
3. What types of careers were you introduced to in this activity? Identify ways each of the professionals presented in this activity can help a patient with cerebral palsy.
4. A company that manufactures phones is losing customers because their phones stop working after a short period. Which step of the design process should the designers of these phones revisit? Explain your answer.
Activity 1.1 Foot Orthosis Instant Design Challenge - Design Process Reflection Table

Complete this table as you work on Part 3 of the Foot Orthosis Instant Design Challenge activity.

- In column A, include what your team did for this step in the design process as you worked on the instant design challenge.
- In column B, include what additional things your team could have done related to this step in the design process.

<table>
<thead>
<tr>
<th>Design Process Step</th>
<th>(A) What you did</th>
<th>(B) What you could have done</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define a Problem</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generate Concepts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design a Solution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Build and Test Solution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Evaluate Solution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Present Solution</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Activity 1.1 Instant Design Challenge Grading Rubric

<table>
<thead>
<tr>
<th>Element</th>
<th>3 Points</th>
<th>2 Points</th>
<th>1 Points</th>
<th>0 Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation</td>
<td>Documentation included a lot of detail and several drawings the team used throughout the process.</td>
<td>Documentation included some details and a few drawings the team used throughout the process.</td>
<td>Documentation included little detail and at most one drawing the team used throughout the process.</td>
<td>No documentation was provided.</td>
</tr>
<tr>
<td>Use of Materials</td>
<td>Materials were used appropriately and efficiently, without any waste.</td>
<td>Materials could have been used more efficiently.</td>
<td>Some of the materials were not used appropriately and materials were wasted.</td>
<td>Use of materials was inappropriate and a lot of materials were wasted.</td>
</tr>
<tr>
<td>Prototype Construction</td>
<td>All criteria were met.</td>
<td>All but one criteria were met.</td>
<td>Multiple criteria were not met.</td>
<td>None of the criteria were met.</td>
</tr>
<tr>
<td>Present Solution</td>
<td>The presenter addressed all the topics listed in the presentation section.</td>
<td>The presenter addressed some of the topics listed in the presentation section.</td>
<td>The presenter addressed a few of the topics listed in the presentation section.</td>
<td>The presenter did not address any of the topics listed in the presentation section.</td>
</tr>
<tr>
<td>Collaboration and Teamwork</td>
<td>The student consistently communicated ideas effectively, respected varying opinions, engaged in compromise, and completed tasks in a timely manner.</td>
<td>The student often communicated ideas effectively, respected varying opinions, engaged in compromise, and completed tasks in a timely manner.</td>
<td>The student rarely communicated ideas effectively, respected varying opinions, engaged in compromise, or completed tasks in a timely manner.</td>
<td>The student did not communicate ideas effectively, did not respect varying opinions, did not engage in compromise, and did not complete tasks in a timely manner.</td>
</tr>
<tr>
<td>Reflection (to be completed later in the activity)</td>
<td>The student considered all the questions provided for the reflection section and provided well-thought reflections.</td>
<td>The student considered most of the questions provided for the reflection section and provided good reflections.</td>
<td>The student considered a few of the questions provided for the reflection section and provided poor reflections.</td>
<td>The student did not complete the reflection table.</td>
</tr>
</tbody>
</table>
A Picture Is Worth a Thousand Words

Introduction

We communicate ideas every day by talking with friends, texting messages, or sharing videos. Engineers often communicate their design ideas visually. Sketches are a quick way to share ideas with others. Even if you think your drawing looks awful, a sketch can be worth a thousand words. With some sketching practice and an understanding of sketch types, you will improve your ability to quickly and effectively transfer your design ideas to a visual representation to share with team members.

Before you begin, watch Types of Sketches video, which describes the following sketch types you will learn to draw in this activity.

Video: Types of Sketches

Refer to your downloadable resources for this video.

Materials

- Ruler
- ¾-cubic-inch linking cubes
- Basic classroom or household object
- Isometric graph paper
- Cartesian graph paper
- Gateway notebook

Resources

Activity 1.2: Sketching Reference
Procedure

Part 1: Thumbnail Sketch

1. Create a [thumbnail sketch](#) on Cartesian (square) graph paper of a small object from either your home or classroom. Remember to make the width and height of the object proportional in your sketch. Add some basic details and darkness to the lines before you share your thumbnail sketch.

2. After you’ve completed your thumbnail sketch, trade sketches with a classmate and answer the following questions:
   - Can each of you understand the other’s sketch?
   - Can you suggest details that they might include or change to make the sketch clearer?

Part 2: Isometric Sketch

As shown in Figure 2, an isometric sketch is drawn at a 30-degree angle from the horizontal base line, to show three sides simultaneously. Isometric graph paper and a ruler will help you draw straight lines at this angle.

3. Using isometric graph paper, create an [isometric sketch](#) for a design of a cardboard box that has a rectangular hole cut into one side of the box.

4. After you’ve completed your isometric sketch, trade sketches with a classmate and answer the following questions:
   - How does your classmate’s isometric sketch compare with yours?
   - If your sketches are different, why do you think your sketches are not identical?
   - How does an isometric sketch differ from a thumbnail sketch?

Part 3: Multiview Sketch

In the following steps, you will create a [multiview sketch](#) of the object shown on the left in Figure 3. If necessary, use five linking cubes to recreate the object, as shown on the right in Figure 3.
5. Use isometric graph paper to create an isometric sketch of the object in Figure 3.
6. Cut out the isometric sketch and paste it onto Cartesian (square) graph paper. Position the isometric sketch in the top-right corner of the graph paper.
7. Using the example layout shown in Figure 4, draw the three primary views (TOP, FRONT, and RIGHT) of the object in Figure 3.

*Figure 4. Multiview Layout Example*
8. To add your multiview sketch to your Gateway Notebook, paste the sketch itself or insert a photo.
9. On Cartesian (square) graph paper or in your Gateway Notebook, practice drawing multiview sketches of the following objects presented as isometric sketches. You may want to build the objects with linking cubes to help you see the three primary views of each object.

**Note**: Use hidden lines where appropriate. Refer to the Sketching Reference for information on line types.

1.

2.

3.

4.
Part 4: Mystery Object (Optional)

10. Using the multiview sketch in Figure 5, build the three-dimensional object with linking cubes. Think about each view and how a three-dimensional object would look given each side’s projection.

Note: For information about different sketching line types, review the Sketching Reference resource.
11. When you’ve finished constructing the three-dimensional object, draw the isometric sketch that’s missing in this multiview sketch on isometric graph paper.

12. To add your isometric sketch to your Gateway Notebook, paste the sketch itself or insert a photo.

**Conclusion**

1. Describe three instances where you’ve seen sketches used to communicate an idea. What type of sketch was used? Explain why you think that type of sketch was chosen.
2. Why would a designer choose to use an isometric sketch rather than a perspective sketch to share their idea with a design team member?
3. What are the benefits of using a multiview sketch to communicate a design?
4. What additional information could you add to a sketch to provide other team members with a more accurate design drawing?
Activity 1.2 Sketching Reference

Thumbnail Sketching

In thumbnail sketching, it’s important to keep it simple, but make sure to capture important details. For example, in a thumbnail sketch of this block, it’s not necessary to show the grain of the wood, but the letters on the faces of the block are important.

Sketching Line Types

Four basic types of lines are used when creating sketches.

- Construction lines are lightly drawn lines that you can use to help you draw other lines properly. You can erase construction lines after you sketch an object.

- Object lines are thick lines used to show visible edges of an object. Sometimes construction lines are converted to object lines.

- Hidden lines are used to show interior (inside) details not visible from a particular view of an object.

- Center lines are used to show the center of arcs, circles, or symmetrical parts of an object.
Isometric Sketching

Isometric sketching is a little more involved. Remember that all non-vertical lines of an isometric sketch are parallel at a 30-degree angle from the baseline.

Unlike perspective sketching, there is no foreshortening of objects that are closer to you. Imagine the object shown in Figure 2 split into equally-shaped blocks. The size of the furthest block is the same as the closest block in isometric sketching.
Multiview Sketching

For a multiview sketch, consider the position of your eyes as you observe the object.

To break down your object into its multiview sketch components, consider the faces of the object you see from each view.

Figure 4. Primary Views

Figure 5. Multiview Sketch Showing Orthographic Projections
Activity 1.3

How Big Was That Fish?

Introduction

Have you ever heard someone tell a story about their fishing trip several times, and each time the story is told the fish gets bigger? Often we get excited about the size of the fish we catch and stretch the truth a little bit.

Measuring with **accuracy** and **precision** is important when catching fish, measuring your room for new curtains, measuring the distance you threw the shot put in a track meet, or designing a new toy. Accurate measuring allows you to purchase the right amount of paint when painting your bedroom or the right amount of lumber to build a shed.

In this activity you will:

- Use precise measuring tools to practice measuring skills and conversions to different units.
- Learn how to **dimension** a sketch and use those values to calculate area, **volume** and **surface area**.

Materials

- PLTW Gateway Formula Sheet
- Computer with Internet access
- U.S. Customary and metric (SI) ruler
- **Dial caliper**
- Calculator
- Linking cubes
- Gateway notebook

Procedure

Part I: Measuring

1. Take the Measuring and Unit Conversions readiness assessments. There are four assessments:

Refer to your downloadable resources for this material. Interactive
2. If you missed more than one question on any of the readiness assessments, complete the tutorial for that topic. There are four tutorials:
   - U.S. Customary Measurement Tutorial
   - Metric (SI) Measurement Tutorial
   - Dial Caliper Measurement Tutorial
   - Unit Conversions Tutorial

3. Complete the Measuring and Unit Conversions Summative Assessment.


Part 2: Dimensioning

5. Watch the tutorial on Dimensioning Guidelines. Stop the tutorial when necessary to write the dimensioning guidelines in your Gateway Notebook.
6. Copy the multiview sketch below into your Gateway Notebook. Make sure your views are properly aligned as shown in Figure 1 (the TOP view directly above and in line with the FRONT view, the RIGHT view directly right of and in line with the FRONT view).
7. Using a metric (SI) ruler and the dimensioning rules you took notes on from the tutorial, properly dimension the multiview drawing.
8. Have your teacher check your dimensions before you go on to the next step.
9. Assemble five linking cubes, to match the example in Figure 2. Sketch the multiview (top, front and right sides) of the object in your Gateway notebook. Measure and dimension using U.S. Customary units.

**Note:** Ignore the holes and connectors. (Remember, your dimensions will be in fractions.)

10. In your Gateway Notebook, draw a multiview (top, front and right side) of the same object again; this time measure the drawing and dimension using Metric (SI) units.

**Note:** Ignore the holes and connectors. (Remember, your dimensions will be decimal numbers.)

11. Draw the same object again in your Gateway Notebook, this time measure the drawing and dimension using the dial caliper.

**Note:** Ignore the holes and connectors. (Remember, your dimensions will be decimal numbers.)

12. Compare your drawings with a classmate. Correct your drawing based on feedback from your classmate.

**Part 3: Surface Area and Volume**

13. Watch the tutorial on **Using Dimensions to Calculate Surface Area and Volume**. Use your PLTW Gateway Formula sheet and document your math calculations for the following questions in your Gateway Notebook.
Calculate the surface area and volume of the block you created for Steps 9, 10 and 11 using your U.S. Customary dimensions, metric dimensions and dial caliper dimensions.

**Note:** Ignore the holes and connector.

- If a pint of paint will cover five square meters, how many of the five-piece blocks you created can you paint with one pint of paint?
- Find the volume of one of the linking cubes using U.S. Customary units. What is the volume of 5 linking cubes? What is the volume of 10 linking cubes? Ignore the holes and connector.

14. Take the Surface Area and Volume Summative Assessment.

Refer to your downloadable resources for this material. Interactive content may not be available in the PDF edition of this course.

**Conclusion**

1. Why is it important to measure and document measurements with accuracy and precision?
2. Why is it necessary to include units when measuring and dimensioning?
3. Describe two places where you have seen dimensioned drawings. Explain why the dimensions were needed for both situations.
4. Why are multiview sketches used to document and communicate design ideas with accuracy?
5. Imagine you are a toy designer. How would you use measuring, dimensions, volume and surface area information to create your toy designs?
Investigate the Inside

Introduction

One way to learn more about how an object was created and functions is to take the object apart. Similar to scientists performing anatomical dissections to learn about how an animal or plant functions, engineers perform mechanical dissections on objects and mechanisms to better understand how they were made and how they work. Objects are carefully taken apart with close observation and documentation during each step of the dissection.

Imagine yourself as a mechanical detective. You’re taking apart a mysterious machine to learn more about how it works. You remove each piece carefully and try to disturb as little of the machine as possible. Each piece you remove is evidence that must be photographed, identified, and catalogued. Mechanical dissection helps you learn about the parts of the machine and how they work together.

During this project, you will work in a team to carefully dissect a puzzle toy.

As you remove the pieces, document how the puzzle is disassembled. This is important for you to be able to reassemble the puzzle and design modifications to the toy that would make it more usable for a child with cerebral palsy (CP).

After removing the parts, you will document the parts with sketches and annotations.

Finally, you will design a modification for the puzzle toy, determine the optimal team design solution, and present your design concept.

Materials

- Toy
- Dial caliper
- Camera
- Isometric graph paper
- Cartesian graph paper
- Gateway notebook

Resources

Project 1.4 Rubric
Procedure

Part 1: Dissect and Document

1. Follow the team norms developed in Activity 1.1 Foot Orthosis Instant Design Challenge, and as a team, carefully take apart each part of the toy provided.

2. Take at least three photos of the process for documentation. Attach and label the photos in your Gateway Notebook.
3. Make notes and thumbnail sketches as needed for additional documentation of the steps you follow to dissect the toy. This will be important for reassembling the toy and making design modifications.
4. As your team dissects the toy, brainstorm and document in your Gateway Notebook ways to make modifications that would make the toy more accessible to children with cerebral palsy. Think about the toy’s size, shape, weight, color, and texture.

Part 2: Sketch with Dimensions

5. On isometric graph paper, each student in your team draws an isometric sketch of one of the toy’s parts that could be modified.
6. Attach your isometric sketch in the right-hand corner of Cartesian (square) graph paper in your Gateway Notebook.
7. Draw a multiview sketch of the part, including the top, front, and right primary views.
8. Use precision measuring tools to measure the part and add dimensions to clearly communicate the part’s features.
Part 3: Design Modifications

9. Using your dissection and toy part documentation, create a multiview sketch of your own idea showing a modification to the toy that would benefit a child with cerebral palsy. Your sketch could show a change to a single part of the toy or a change to the overall toy and how it is assembled. Use the following steps of the design process to design your toy modification.

- Discuss with your team what you learned in the videos for Activity 1.1 Foot Orthosis Instant Design Challenge. What difficulties might someone with CP experience?
- Pick one impairment that your team wants to concentrate on, such as difficulties in grasping objects, and design a modification to the toy you dissected.
- With your team members, brainstorm criteria and constraints that you want your toy design to follow. Document these design requirements in your Gateway Notebook.
- Research is an important part of generating new concepts. Research modifications specific to the impairment that your team is concentrating on that would be beneficial to
a child with cerebral palsy. In your Gateway Notebook, document what you learn and the sources.
- Draw your toy modification design as a multiview sketch in your Gateway Notebook.
- Dimension and annotate your sketch so that your team members can understand the modifications in your design.

**Part 4: Decision Matrix and Presentation**

10. Watch the Decision Matrix presentation.
11. With your team, use the Decision Matrix Template to list the criteria and constraints you identified in Part 3 for each of the designs your team members created.
12. Use the decision matrix to select the best toy modification for a child with cerebral palsy.
13. In your Gateway Notebook, create a working drawing of your final solution that includes a dimensioned multiview and an isometric sketch.
14. Present your team’s design ideas, decision matrix, and justification for the design solution to the class. An effective presentation includes:
   - Participation from all team members.
   - Creative delivery of the information while staying on topic.
   - A relaxed and self-confident presenter.
   - Effective and appropriate use of body language, speaking voice, and eye contact.
   - Visual aids that provide information with limited text that complements the presentation.

**Conclusion**

1. After viewing each of the presentations, which team’s modification to the toy would be best for a child with cerebral palsy? Explain why.
2. Describe three characteristics of an effective presentation.
3. Why is a decision matrix an important tool to use in the design process?
4. What are the benefits of mechanical dissection?
5. Describe three ways you provided documentation as you completed this project.
# Project 1.4 Investigate the Inside Rubric

<table>
<thead>
<tr>
<th>Element</th>
<th>5 Points</th>
<th>4 Points</th>
<th>3 Points</th>
<th>2 Points</th>
<th>1–0 Points</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Research and Documentation</strong></td>
<td>Research is documented with appropriate citations. Team research shows a variety of resources and includes three or more sources.</td>
<td>Research is documented on some topics. One or two do not have proper citation information. Team research is limited to two or three resources.</td>
<td>Research is randomly completed with little or no documentation of sources.</td>
<td>There is no research other than what is available from the lecture notes.</td>
<td>There is little or no evidence of research in the notebook.</td>
</tr>
<tr>
<td><strong>Design Sketches</strong></td>
<td>Sketches are complete and annotated to show all important information. All designs are unique and are completed in pencil.</td>
<td>Sketches are not complete and are missing important information, such as measurements. All designs are unique and are completed in pencil.</td>
<td>Sketches are missing more than half of the necessary dimensions and annotations. Designs are not unique.</td>
<td>Sketches are not complete. Dimensions and annotations are not complete and not accurate. Sketches are not created with pencil.</td>
<td>There are few or no sketches in the notebook.</td>
</tr>
<tr>
<td><strong>Decision Matrix</strong></td>
<td>The decision matrix is complete with all criteria listed and each drawing evaluated. The student can effectively justify the final decision.</td>
<td>The decision matrix does not evaluate the required number of drawings. The student can justify the final decision.</td>
<td>The decision matrix criteria are incomplete. The selected option is not clearly justified using the matrix.</td>
<td>The decision matrix is missing both criteria and evaluations of drawings. The final project decision cannot be justified using the matrix.</td>
<td>The decision matrix is excessively deficient or missing. The final project decision cannot be justified using the matrix.</td>
</tr>
<tr>
<td><strong>Working Drawing</strong></td>
<td>All multiview and isometric sketches are shown in the proper location with proper dimensions identified.</td>
<td>Most multiview and isometric sketches are shown in the proper location with some dimensions in error.</td>
<td>Multiview and isometric sketches are shown, but with an error in either proper location or proper dimensions.</td>
<td>Multiview and isometric sketches contain many errors.</td>
<td>Multiview and isometric sketches are incomplete or are missing.</td>
</tr>
<tr>
<td></td>
<td>All students participate in the presentation. The presenter effectively and</td>
<td>All students participate in the presentation. The presenter</td>
<td>Most students participate in the presentation. The presenter</td>
<td>Some students participate in the presentation. The presenter</td>
<td>Multiview and isometric sketches are incomplete or are missing.</td>
</tr>
<tr>
<td>Present Solution</td>
<td>Solution</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>----------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>creatively delivers the information while staying on topic. The presenter appears relaxed and self-confident. Body language, voice modulation, and eye contact are effectively used.</td>
<td>adequately delivers the information while staying on topic. The presenter appears relaxed and self-confident. Body language, voice modulation, and eye contact are mostly appropriate.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The presenter delivers the information, but does not stay on topic. The presenter appears tense or nervous. Body language, voice modulation, and eye contact are inappropriate or lacking.</td>
<td>omits important information and does not stay on topic. The presenter appears tense or nervous. Body language, voice modulation, and eye contact are inappropriate or lacking.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Few students participate in the presentation. The presenter does not effectively deliver the necessary information.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Teamwork</th>
<th>Teamwork</th>
</tr>
</thead>
<tbody>
<tr>
<td>The student consistently listens to all team members, respects varying opinions, communicates ideas and opinions effectively, and engages in compromise. Student completes their portion of the project on time.</td>
<td>The student generally listens to team members, respects varying opinions, communicates ideas and opinions effectively, and engages in compromise. Student completes their portion of the project on time.</td>
</tr>
<tr>
<td>The student does not always listen to team members or show respect for varying opinions. The student does not always communicate ideas and opinions or engage in compromise. Student completes most of their portion of the project on time.</td>
<td>The student does not listen to other team members, does not show respect for varying opinions, and does not effectively communicate ideas and opinions or engage in compromise. Student completes some of their portion of the project on time.</td>
</tr>
<tr>
<td>The student shows little to no evidence of communication or cooperation. Student does not complete their portion of the project on time.</td>
<td></td>
</tr>
</tbody>
</table>
Building Blocks

Introduction

Have you ever used an object around the house or school and wondered how did someone get the idea to make this thing? Starting with an idea and making it a reality is exciting. The process often requires collaboration within a team throughout the different steps of the design process. How do designers describe their ideas to others? Providing enough information to communicate a complex design or invention usually requires designers to create technical drawings.

In Lesson 1 you learned about different types of sketches used during the design process. In this lesson, you will learn to use various types of modeling as you work on the puzzle cube project. You will have the opportunity to be creative and to develop your sketching and modeling skills.

Materials

- 27 ¾-cubic-inch linking cubes for each pair of students
- Isometric graph paper
- Cartesian graph paper (if using digital notebooks)
- Puzzle Design Challenge Brief
- Computer with GeoGebra software installed
- Gateway notebook

Resources

- Puzzle Design Challenge Brief

Procedure

Part 1: Define the Problem

The first step of the design process is to define a problem. In this step, designers identify a problem or opportunity and validate it by asking questions and researching possible existing solutions. By the end of this step, the designers will have clearly defined the problem statement and a design statement. One tool designers use to document this step is a Design Brief.
1. Refer to the Puzzle Design Challenge Brief. It includes all the information you need to know about the puzzle cube design challenge for this lesson. You will be working on the items listed in the Deliverables section of the brief over the course of multiple activities.

2. Study the design brief closely. Then answer the following in your Gateway Notebook.
   - Explain the difference between the Problem Statement and the Design Statement.
   - Explain what criteria and constraints are and why they are important to include in the design brief.

3. As a class, decide on the target solution time for students in grades 4–9 and the target solution time for adults, and fill in the corresponding blanks in the Puzzle Design Challenge Brief.

4. Paste a copy of your completed design brief in your Gateway Notebook to document step 1 of the design process.

**Part 2: Generate Concepts**

The second step of the design process is to generate concepts. During this step, designers try to exhaust all possible combinations or solutions to a problem to select the best alternative.

You can approach the puzzle cube problem in different ways. Common computational thinking practices used by engineers, scientists, and computer scientists are problem decomposition and algorithmic thinking. This means that engineers and scientists break down a complex problem into smaller, more manageable problems. Then they follow an algorithm to solve each of the smaller problems.

To decompose the puzzle cube problem, consider the following steps:

1. Given the constraints listed in the design brief, brainstorm the possible part size combinations.
2. Determine the possible shapes for each of these sizes.
3. Determine which parts will fit well with the other parts to complete the puzzle cube.
4. Let’s begin with the first step. To brainstorm the puzzle part size combinations, begin by reviewing the design brief constraints. Which constraints affect the number of puzzle parts and their sizes?
5. For a better understanding of the different combinations that can be used to solve this problem, work with your teacher to generate a tree diagram. Tree diagrams, like graphs and charts, are mathematical models that represents a real-world situation.
6. After you complete the tree diagram, answer the following questions:
What are the possible combinations of 4-, 5-, and 6-cube parts that add up to 27 total cubes?

Why did the tree only have five levels?

Why did the tree only have the options 4, 5, and 6?

Why did the first and second levels of the tree have the value “6” as the only option?

Describe the algorithm you used to work with the tree diagram. Include the steps you used to generate the tree as well as the steps you took to identify the correct combinations.

8. With your partner, collect 27 ¾-cubic-inch linking cubes and build five puzzle parts that will complete the 3x3x3 puzzle cube. Keep in mind the following:

- Your puzzle parts must comply with the criteria and constraints you learned about from the design brief and the tree diagram.
- Using a different color for each puzzle part can make it easier to visualize.
- Be patient. This step will require you to try different combinations.

9. Once you have built your puzzle, create an isometric sketch for each of the five puzzle parts.

- Use isometric graph paper.
- Make sure to add basic dimensions to your isometric sketches (height, width, depth).
- Remember each side of a cube is ¾ inch.

This step is an important step of the documentation process and will be used again in the next steps of the process.

Part 3: Design a Solution

The third step of the design process is to design the solution to the problem. During this step, designers create a detailed design using technical drawings and models. The drawings and models provide the technical details necessary to produce a precise solution.

10. Use the isometric sketches from Part 2 of this activity to create a multiview sketch for each part of your puzzle cube.

- Cut and paste the isometric sketch from Figure 1. Multiview Example
Part 2 into your Gateway Notebook. If you are using a digital notebook, then paste the isometric sketch on Cartesian graph paper.

- Add the additional three views onto the Gateway Notebook page (or Cartesian graph paper if using a digital notebook). Make sure to properly dimension your multiview drawings. Remember each side of a cube is ¾ inch.

Note that having the actual puzzle parts that you built in Part 2 will help you visualize the top, front, and right views more easily.

11. Share your sketches with your teacher.

### Part 4: Explore Coordinate Planes and Shapes

12. Watch The Coordinate System video about 2D coordinate planes.

Video: 2D Coordinate System

Refer to your downloadable resources for this video.

13. Complete the 2D Coordinate Plane interactive challenge.

14. Launch GeoGebra on your computer. By default, it starts with the Algebra and Graphics views.

15. To show the Graphics style bar, click the arrow on the Graphics title bar.

**Figure 2.** Graphics Style Bar

16. Take a minute to explore the options on the style bar.

What can you do with each of these four options?

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Option Image]</td>
<td>![Function Image]</td>
</tr>
</tbody>
</table>
17. From the Help menu, select Tutorials. On the Tutorials web page that opens, select to open the GeoGebra Algebra and Graphing Quickstart tutorial.

18. Before you continue to the next step, explore the following topics in the tutorial.

   - Under Algebra Quickstart:
     - How to Use GeoGebra’s Tools

   - Under Learn more about GeoGebra:
     - The Graphics Tools
     - How to Change Color, Size and Style
     - How to Show Name, Value or Caption of Objects

19. Create a new File (select File > New) and save it as *MyFirstChallenge_yourname.ggb*.

20. Complete the following tasks:

   - From the Graphics style bar, click the Grid icon to show the grid.
   - Add a point A with coordinates (8, 3).
   - Add a point B with coordinates (10, 5).
   - Draw a line that passes through A and B.
   - Draw a line that is perpendicular to line segment AB. This will create a point C.
   - Draw a square with vertices D(5, 0), E(5, 5), F(0, 5), and G(0, 0).
   - Change the color and the opacity of the square. The opacity is the extent to which the shape is see-through.
   - Draw a circle with center (2, 2) and a radius of 1.
For more accurate drawings, you can edit the values of the objects directly in the Algebra window.

21. Save your work.

22. Take a few minutes to discuss with a classmate how you accomplished the tasks above.

Part 5: Investigate Solid Shapes

23. Watch the 3D Coordinate System video.

Video: 3D Coordinate System

Refer to your downloadable resources for this video.

24. Complete the 3D Coordinate System interactive challenge.

25. In GeoGebra, create a new file and save it as SolidShapes_yourname.ggb.

26. From the View menu, open the 3D Graphics view. Notice how the options on the main toolbar change based on the graphics view that is currently active.

27. Resize the 3D Graphics view to take up about half of the window.

28. To show the 3D Graphics style bar, click the arrow on the 3D Graphics title bar.

Figure 3. 3D Graphics Style Bar

- Take a minute to explore the options on the 3D Graphics style bar.
- What can you do with each of these options?

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Option 1]</td>
<td></td>
</tr>
<tr>
<td>![Option 2]</td>
<td></td>
</tr>
<tr>
<td>![Option 3]</td>
<td></td>
</tr>
</tbody>
</table>
29. Using the View Direction icon on the style bar, select Rotate back to default view. This option sets the view back to the original view, which displays the isometric view of the space, also referred to as “orthographic” in GeoGebra.

30. Consider the following 2D and 3D Graphics views.

- The red axis in the 3D view is the x-axis, which corresponds to the horizontal axis in the 2D view.
- The green axis in the 3D view is the y-axis, which corresponds to the vertical axis in the 2D view.
- The blue axis in the 3D view is the z-axis, which represents the third dimension of a solid object. This dimension is not applicable in the 2D view.

Figure 4. Pyramid in 2D and 3D Views
- The gray plane in the 3D view corresponds to the two-dimensional plane in the 2D view. Since the 2D view shows only the xy plane, the only part of the 3D pyramid that can be displayed in the 2D view is the base of the pyramid, because the base lies in the xy plane.

31. Take a few minutes to explore some of the tools in the 3D Graphics toolbar. Try 2D objects, such as lines and polygons. Then try 3D objects, such as cubes, spheres, prisms, and cylinders.

![Figure 5. 3D Graphics Tools](image)

Note that most of the toolbar icons expand into a list of tools to choose from. As shown in the figure, when you click the down arrow in the bottom-right corner of the Pyramid icon, a list of other tools is displayed.

32. Select the Move tool. Then click anywhere in the 3D Graphics view and drag to rotate the 3D view left, right, up, and down. This helps you see your objects in 3D from different angles.
33. Reset the view to the default (original) view.

34. To delete all the objects and start over, click in any of the views, choose Select All from the Edit menu, then select Edit > Delete.

Part 6: Solid Modeling

Your last challenge in this activity is to create a 3D representation of one of your puzzle cube parts. Decide which puzzle part you would like to model. You may refer to the multiview sketches in your Gateway Notebook or to the actual puzzle part you modeled with the linking cubes.

35. In GeoGebra, create a new file and save it as *PuzzlePart_yourname.ggb*. Then add the 3D Graphics view.

36. Using the tool of your choice, draw the first piece of the puzzle part, starting at the origin with the side 2 units long.

37. Similarly, add the other cube pieces to the 3D model. To make it easier to see the different cubes, you can give each cube a different color.

![Figure 6. Cubes in Different Colors](image_url)

38. Complete the model of your puzzle part. To be able to add the vertices, spin the 3D view around as needed.

39. Explore the different View Directions to see the puzzle part from the FRONT, TOP, and RIGHT. They should match up with the primary views in your multiview sketch.

40. Once completed, export the 3D design into an image file, as follows:
Click anywhere in the 3D Graphics view.

Select Export from the File menu, and choose Graphics View as Picture…

![Export as Picture Dialog](image)

In the Export as Picture dialog box, keep the default values and click Save.

41. Add the image of your 3D model to your Gateway Notebook.

42. Share your design with your teacher.

**Part 7: Using Nets (Optional)**

43. In a new GeoGebra file, open the 3D Graphics view.

44. Click in the Graphics view (left) and use the Regular Polygon tool to draw a square with side = 2 units in the center of the xy plane. Notice how the square also appears on the 3D Graphics view.

45. Click in the 3D Graphics view and select the Extrude to Prism or Cylinder tool found under the Pyramid tool.

46. Click on the square in the 3D Graphics view. The extrude feature will prompt you to enter the altitude, or height, for your prism. Enter “3”. This will create a prism, using the square that you created as its base and the altitude that you entered for its height. Extruding is a very common method to create solid shapes from a 2D shape.

47. Click the Net tool also found under the Pyramid tool. Then click on the prism. This will display the geometry net of the prism. A geometry net is a two-dimensional shape that can be folded to form a three-dimensional shape or solid. A solid may have different nets. Nets can be very helpful to visualize all the faces that make up a 3D solid and to calculate the surface area of a solid.
Figure 8. Net of the Prism

48. Use the slider in the top-left corner to open and close the net.

49. Refer to the net you created in GeoGebra and answer the following questions:
   
   - What do the values shown in red in the Algebra window represent?
   - What is the total surface area (in units\(^2\)) of the prism?
   - Draw another net that will create the same solid shape shown.

Conclusion

1. Why is it important to use a documentation tool such as the Design Brief?

2. How did the mathematical model used to generate concepts help you brainstorm possible solutions to the puzzle?

3. What is the purpose of the coordinate system?

4. Why is it helpful to model an object in 3D?

Trademark Attribution The GeoGebra logo and software are property of the GeoGebra Group. All other brand names, product names, or trademarks belong to their respective holders.
Activity 2.1 Puzzle Design Challenge Brief

Client | Fine Office Furniture, Inc.
--- | ---
Target Consumer | Ages: Middle-school age
Designer | 

Problem Statement

A local office furniture manufacturing company throws away tens of thousands of scrap ¾ inch hardwood cubes that result from its furniture construction processes. The material is expensive, and the scrap represents a sizeable loss of profit.

Design Statement

Fine Office Furniture, Inc. would like to return value to its waste product by using it as the raw material for desktop novelty items that will be sold on the showroom floor. Design, build, test, document, and present a three-dimensional puzzle system that is made from the scrap hardwood cubes. The puzzle system must provide an appropriate degree of challenge to middle school students.

Criteria and Constraints

- The puzzle must be fabricated from 27 ¾ inch hardwood cubes.
- The puzzle system must contain exactly five puzzle parts.
- Each individual puzzle part must consist of four to six hardwood cubes that are permanently attached to each other.
- At least two puzzle parts must be made up of six hardwood cubes.
- No two puzzle parts can be the same.
- The five puzzle parts must assemble to form a 2¼ inch cube.
- Some puzzle parts should interlock.
- Students in grades 4–9 should need an average of ______ minutes/seconds to solve the puzzle. (Fill in your target solution time.)
- Adults should need an average of ______ minutes/seconds to solve the puzzle. (Fill in your target solution time.)

**Deliverables**

Use your Gateway Notebook to write a detailed description of the Design Process. Summarize your work during each step of the process. Include documentation (written work, sketches, CAD drawings, images) to support your discussion. Your documentation must include the following information located in the appropriate Design Process step:

- Puzzle Design Challenge Brief (Activity 2.1 Part 1)
- Brainstorming of possible part combinations (Activity 2.1 Part 2)
- Multiview sketch, fully dimensioned, of each of the five puzzle parts in your design (Activity 2.1 Part 3)
- Isometric view of each puzzle part using computer-aided design software (Activity 2.2 Part 3 and Project 2.3)
- Prototype (and image) of your puzzle (Project 2.3)
- Statistics related to the solution time of your puzzle (Project 2.3)
Take Modeling to Another Dimension

Introduction

Have you ever watched a computer-animated movie and wondered how animators and designers made objects look and appear realistic? The environments and characters are created using 3D modeling tools. These technological tools aren't just used to create awesome special effects and movies. Many physical objects you use every day are first created using 3D modeling, also called solid modeling, during the design process. Space rovers, furniture, and electronic devices are typically designed first with a solid modeling application.

When an object is created in 3D on a computer, the designer can move the computer model and rotate it to view the object from any direction. It’s easy for a designer to look at the back, see underneath, or even cut away part of the object to look inside using a computer-aided design (CAD) application.

In this activity, you will use two-dimensional shapes to create solid models for your puzzle cube parts in a CAD application.

Materials

- ¾-cubic-inch linking cubes
- CAD application (SketchUp® Pro)
- SketchUp Pro template file
- Puzzle cube part combination sketches from Activity 2.1 Building Blocks
- Reference documents
  - Activity 2.2 SketchUp Pro Student Resource
  - SketchUp Pro Quick Reference Card for Windows
  - SketchUp Pro Quick Reference Card for Mac OS X

Resources

- SketchUp Reference Mouse
- SketchUp Reference Windows
### Procedure

#### Part 1: Geometric Primitives and Measurement

1. Open SketchUp Pro.

2. Select **Choose the Template** and select a template. Your teacher will provide guidance for the appropriate template to use. A pre-installed template, such as **Woodworking – Inches**, may be used.

3. At the bottom of the Welcome dialog, elect **Start using SketchUp**.

4. Learn about features and tools of SketchUp Pro through the Getting Started videos at the SketchUp Learn website.

   **SketchUp Learn | SketchUp**

   - Watch the video Getting started with SketchUp - Part 1. Recreate the actions using your SketchUp Pro application as shown in the video. Note that guidance is provided in the lower right of the SketchUp window for each tool that you use.

   - Watch the Getting started with SketchUp - Part 2 video until the time reaches 3:50. Recreate the actions using your SketchUp Pro application as shown in the video.
5. Change the Camera Standard View to other options. What do each of these options do?

6. Select the **Iso Standard View**.

   **Note:** Note that you should always make sure your units match the unit of measurement you require for your solid model. In this case, your model’s dimensions are provided in inches. You are going to create a rectangular prism that will have a total volume of 6 in.$^3$. Volume = \( l \times w \times h \)

7. Before you begin designing the model, determine the length, width, and height measurements for a box object that would give you a volume of 6 in.$^3$. Write down these dimensions for future use.

8. Create a Rectangle with precise dimensions of 2 in. x 1 in. with a corner placed at the origin.
   - Select the **Rectangle** tool.
   - Select the origin to start the rectangle.
   - Release the mouse button.
   - On the keyboard, type 2\"”, 1”” and then press **Enter**.
   - Confirm that the Dimensions shown on the bottom right of the screen are “2, 1”.

9. Use the Push/Pull tool to create a solid with a height of 1 in. This is an additive method which will be explained later.
   - Select the **Push/Pull** tool.
   - Select the rectangle.
○ Release the mouse button and then move the mouse upward to show the direction to pull the rectangle.

○ On the keyboard, type 1” and then press **Enter**.

○ Confirm that the Distance box on the lower right shows “ 1” ”.

---

**Figure 3.** Push/Pull

10. View the volume of the shape.

○ To place the object in the center of the screen, select **View, Camera, Standard Views**, and then **Iso**.
Figure 4. Iso View

- Click the Select tool.

- To select the solid shape created earlier, click and drag the mouse to select the entire shape, and then release the mouse button.

Figure 5. Highlight the Shape

- Create a group by one of the following methods.
Select Edit and then Make Group.

![Figure 6a. Make a Group Using the Edit Menu](image)

Right-click the object and then left-click **Make Group**.

![Figure 6a. Make a Group Using the Right-click popup](image)

Notice the Volume value in the Entity Info panel on the right.
Take a screen capture.

- Is the volume of your rectangular prism 6 in.$^3$?
- If not, what dimension can you change to correct the volume?

11. To prepare the object to change its geometry, you first must explode the group that you created earlier. Use one of the following methods to explode a group.

**Note:** Volume information will be displayed in the Entity Info panel for a group.

- To select the group, click anywhere on the shape and then select Edit > Solid Group > Explode.

Right-click anywhere on the object and then click **Explode**.
12. Modify the shape to be a rectangular prism 6 in.$^3$.

13. Create a group again to verify the volume.

14. Take a screen capture. You can take images of your models for digital notebooks or documentation.

Part 2: Creating Models with Additive and Subtractive Methods

An additive solid modeling design method is where an object is created by adding volume to a smaller object. An example is where a shape such as a rectangle is created and the shape is pulled using the Push/Pull tool to create a larger solid object.

15. Use the additive modeling method to create the puzzle part shown in Figure 9. The part dimensions are in inches.

![Figure 9. Multiview of Puzzle Part in Inches](image_url)

- Open a new file in SketchUp Pro.
- Save your model as AdditiveModel_yourname and share it with your teacher to check your dimensions and shape.

A subtractive solid modeling design method is where an object is created by removing volume to create a smaller object. An example is where a rectangle is created and the shape is pushed using the Push/Pull tool to create a smaller solid object.

Copyright © 2017 Project Lead The Way, Inc. All rights reserved.
16. Use the **subtractive modeling** method to create the puzzle part shown in Figure 9.

- Open a new file in SketchUp Pro.
- Save your model as *SubtractiveModel_yourname* and share it with your teacher to check your dimensions and shape.

17. Think about the following questions and check your work.
- Is your additive method solid model identical to your subtractive method solid model?
- Why or why not?

**Part 3: Creating Puzzle Cube Parts**

18. Using your puzzle cube part combinations from Activity 2.1 Building Blocks, trade one of your part sketches with a classmate.

19. Create a solid model of your classmate’s puzzle cube part using SketchUp Pro. Make sure your units and dimensions are correct based on their sketch.

**Note**

Remember to use either the additive or subtractive method or a combination of both to create your model with geometric primitives.

20. When finished, save your file as *PuzzleCubeParts_yourclassmate’sname*.

21. Share your solid model of your classmate’s part with them.
- Does your model accurately reflect your classmate’s sketch? Why or why not?
- Does your classmate’s model accurately reflect your part sketch? Why or why not?

22. Save the puzzle cube part file your classmate created. You will use it during Project 2.3 Puzzle Cube Statistical Analysis.

**Part 4: Designing with Surface Area and Volume Constraints**

A constraint is a requirement that establishes a design condition or parameter. As part of understanding a problem or design opportunity, designers must identify any boundaries necessary for the solution to be successful.

Look at the three 3D-printed objects in Figure 10. Each is a cube that has been cut open to show the inside. Objects created on a 3D printer contain filler structure inside. Since no one typically sees the inside, the filler doesn’t have to fill the entire volume of the object.
The cubes shown in Figure 10 were each created using a different percentage of fill. The first cube was filled at 10%. While it was a strong cube, the designer tried making the inside stronger by raising the fill to 18% in the second cube. The third cube’s volume is 25% filled with the inside walls printed even closer together.

Designers use an object’s total surface area, exterior wall thickness, volume, and the percentage of fill to determine how much 3D-printer material they will need and how much it will cost to print the object.

Before it was cut open, each object in Figure 10 had a length, width, and height of 3 inches to form a perfect cube.

23. Find the total surface area and volume of one cube.
   - Total Surface Area = 6 (l × w)
   - Volume = l × w × h

24. If the fill is set at 10% of the volume, how much volume is filled by 3D-printed material in the first cube in Figure 9?

25. Practice using SketchUp Pro with the additive and subtractive methods to create a drinking mug or cup with at least one handle or an easy-to-grip feature. Your mug or cup must meet the following design constraints:
   - Hold a liquid with a volume of at least 15 in.$^3$
   - Have a base that would easily fit onto a square cup coaster with an area of 12.25 in.$^2$

26. Explore other tools under the Shapes menu as shown in Figure 11.
To adjust your design, you can smooth edges and hollow out your primitive objects with these tools. Make sure to give your mug or cup design an appealing appearance as well.

27. Save your mug or cup design as 2.2Mug_yournamex.

After you’ve built a model of your cup or mug, create a section view of the object to inspect the inside and check interior features and measurements.

28. Make the mug a group.

29. Select Tools > Section Plane and then select the top center of the mug as shown in the image. To toggle to the locked plane aligned parallel to the front view plane, press the left arrow key as shown in Figure 12.

30. Left-click the mouse to place the section plane. The model should look like Figure 13.
31. To reposition the object with respect to the section plane to view other sections, select the Move tool as shown in Figure 14.

32. After you inspect the inside dimensions of your mug or cup, press Ctrl + z on the keyboard to revert to your design.
33. Save your finished design as 2.2Mug_yourname and share it with your teacher.

Conclusion

1. Computer-aided design applications provide many useful tools for creating 3D models of an object. What are two tools that you used in the 3D modeling application that you found helpful? Explain how these tools helped you create solid models.

2. Provide step-by-step instructions to explain how to adjust the dimensions of a geometric primitive, such as the length of a box or height of a cylinder.

3. Explain the difference in function among zoom, pan, and orbit navigation tools in a 3D modeling application and describe two ways you can perform each function.

4. If you wanted to create a cylinder-shaped hole in a cube using two geometric primitives, what steps would you use to create it?

5. Why is it important to understand design requirements such as constraints prior to designing a solution?

Trademark Attribution PLTW, Project Lead The Way, and the PLTW logo are registered trademarks of Project Lead The Way, Inc. SketchUp is a registered trademark of Trimble, Inc. All other brand names, product names, or trademarks belong to their respective holders.
Puzzle Cube Statistical Analysis

Introduction

Engineers build prototypes to test a design to decide whether it meets the design criteria. Testing a product and looking at the results can help engineers improve the design. Getting feedback from the people who will use the product also helps ensure that the design meets the needs of users and works well.

In this activity you will:

- Create solid models of all of your puzzle cube parts.
- Prototype your puzzle cubes.
- Test your puzzle cube design and collect data.
- Use a spreadsheet to analyze the data to decide whether your design meets the design criteria.
- Explore options for making your design better.

Materials

- Plastic linking cubes
- Prototyping supplies. Use the items from one or both of the following lists:
  - 3D printer
  - Filament for 3D printer
  - Wooden cubes
  - Colored pencils, paint, or markers
- Stopwatch (or use timer on watch, cellphone, or computer)
- Computer with data collection software (GeoGebra) and 3D-Modeling software (Autodesk® 123D® Design for Education)
- Gateway notebook
Procedure

Part 1: Solid Modeling and Prototyping

1. Create a solid model of each of your puzzle cube parts in 3D-modeling software. As you finish each piece, be sure you save your files to share with your partner and teacher.

2. Model your puzzle parts with plastic linking cubes. Have a partner compare and check your computer designs and plastic linking cubes for accuracy.

3. Prototype your puzzle cubes following your teacher’s instructions.
   
   - 3D print each of your puzzle cubes.

   and / or

   - Glue together wooden cubes to make each of your puzzle cube parts. Color the cubes with paint or markers.

Part 2: Testing

4. Test the solution time of your puzzle cube (how long it takes someone to solve or assemble the puzzle).
   
   - Identify at least five students (grades 4–9) to solve your puzzle.

   - Identify at least five adults to solve your puzzle. Include your parents, teachers, or other adults from your school.

   - Have each test subject solve your puzzle three times.

   - Record the solution times in the Activity 2.3 Puzzle Cube data sheet.


7. Enter the data into GeoGebra from timing the adults and students who solved your puzzle.

8. Calculate the mean or average for each data set (six data sets total: first, second, and third attempts for both students and adults).

9. Calculate the median, lower-quartile median, and upper-quartile median for all six data sets.

10. Use your data to create box-and-whisker plots for all six data sets. You will use your graphs to determine the difficulty of your puzzle in comparison to your classmates’.

11. Describe the relationship between the number of attempts and solution time for students.

12. Describe the relationship between the number of attempts and solution time for adults.

13. Compare your box-and-whisker plots with a partner in your class. From the design brief created in Activity 2.1 Building Blocks, are your actual median times for students and adults close to your goal times?

14. Describe the relationship between the number of attempts and solution time for adults compared to students.

15. Compare your box-and-whisker plots with the rest of your classmates’.

Conclusion

For questions 1–5, use the statistical analysis of your puzzle cube solution:

1. The students solved your puzzle within what range of time? How does this compare to the range for the adults?

2. How do the solution times of students (on their first attempt) compare to the solution times of the adults (on their first attempt)?

3. Compare the solution time for students on their first attempt to the solution time on their third attempt. If your goal is to entertain someone for three minutes with your puzzle cube, is it acceptable for the solution time to get significantly faster each time someone completes the puzzle?

4. Compare the difficulty of your puzzle to the difficulty of your partner’s puzzle. Which puzzle was more difficult to solve? How do you know which one is more difficult?

5. Does your puzzle design meet the solution time design criteria? Explain your answer.

6. If you had time to make a new iteration of your design cube, how would you modify your design? Explain why you would make this change.
Trademark Attribution Autodesk and 123D Design are registered trademarks of Autodesk, Inc. and/or its subsidiaries and/or affiliates in the USA and/or other countries. The GeoGebra logo and software are property of the GeoGebra Group. All other brand names, product names, or trademarks belong to their respective holders.
## Project 2.3 Puzzle Cube Design - Data Sheet

<table>
<thead>
<tr>
<th>Name</th>
<th>Student or Adult</th>
<th>Time 1 (seconds)</th>
<th>Time 2 (seconds)</th>
<th>Time 3 (seconds)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Let’s Simulate to Elucidate

Introduction

Engineers and scientists use modeling and simulation to gather information about how a system will behave without having to perform a test in the real world. Sometimes the systems are too complex, expensive, or dangerous to study physically so models and simulations may be the only way to study these systems. In this lesson, you will explore two computer models used by scientists and physicians. Since a patient’s gait and grasp are two of the most common presentations of cerebral palsy, you will use a modeling and simulation tool to study their musculoskeletal models before you proceed to the unit problem. As you study these models, think about how your observations might enhance your therapeutic toy design.

Materials

Computer with OpenSim software installed

Resources

Open Sim Script

Procedure

Part 1: Computational Solutions

Computer Science is the study of computers and their uses. Computer scientists use computers to develop solutions and artifacts that enhance people’s personal and professional lives. Computational solutions are used in many professions, including mathematics, science, medicine, economics, journalism, art, music, entertainment, and sports.

1. Watch the OpenSim video. Then discuss the following questions as a class.

OpenSim | YouTube

- What is OpenSim?
- Who do you think uses OpenSim and how does the tool help them with their job?

Video: OpenSim Grasp Simulation
When designing computer models, computer scientists need to include all of the data that corresponds to the physical system being modeled. For musculoskeletal models, scientists need to include properties for the bones, joints, and muscles and rules that describe the way they move. Different joints behave differently in a human body. The elbow, for example, has a very different structure and motion from that of the wrist. Therefore, a computer model of an elbow will have properties and rules that are different than those of a wrist model.

Figure 1. Elbow Flexion and Extension

Figure 2. Wrist Flexion and Deviation

Part 2: Using OpenSim for Gait Analysis

In this section of the lesson, you will use OpenSim to investigate crouch gait, one of the most common walking presentations among individuals with cerebral palsy. There are many conditions that can cause crouch gait. One of the causes is having short hamstrings. Orthopedic surgeons will sometimes lengthen the hamstrings of such patients to improve their posture and gait. But first, how can a surgeon confirm that the cause of the crouch gait is short hamstrings?

One possible way is to develop a musculoskeletal model and compare the length of the hamstrings during the patient’s crouch gait cycle to the length of the hamstrings during a normal gait cycle.
Using special motion analysis technology, the data of a patient’s gait is collected and a model is developed for the patient’s gait using tools like OpenSim. In the next steps, you will compare the patient’s crouch gait to a normal gait.

2. Launch the OpenSim application on your computer.

3. Copy the Gait2392_Simbody folder as instructed by your teacher and paste it into your documents folder. You will use your copy of the folder in this activity.

4. Download the file 3.1_OpenSimScript.py from this activity’s Resources tab and save it in your documents folder.

5. Select File > Open Model… and browse for the copy of the Gait2392_Simbody folder that you added to your documents folder in step 3.

6. In the Gait2392_Simbody folder, select the model file gait2392_simbody.osim. The model will load and display the skeleton in the View window.

   ![Figure 3. Musculoskeletal Model](image)

7. In the Navigator window, right-click on the model name and rename it “Normal Gait Model”.

8. To control the view of the model in the 3D View window, you can use the following shortcuts. Try them out in your 3D View window now.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate</td>
<td>Rotate by clicking the left mouse button and dragging.</td>
</tr>
<tr>
<td>Pan</td>
<td>Pan by clicking the left mouse button, pressing the Shift key, and dragging</td>
</tr>
</tbody>
</table>
9. Click the Coordinates tab.

The Coordinates window displays all the joint coordinates in the model and provides controls for changing their values.

![Coordinates Window]

**Figure 4. Joint Coordinates**

10. Use the sliders to change the values of the coordinates and observe what happens in the View window.

11. To reset to the original pose, click Poses and select Default.

12. Select Scripts > Open… and select the script file `3.1_OpenSimScript.py` that you have downloaded earlier in this activity.

   This script contains a computer program that will automatically set up OpenSim with the gait analysis files and plot the length of the hamstring during a normal gait cycle versus the length of a hamstring during the gait cycle of a patient with cerebral palsy.

Copyright © 2017 Project Lead The Way, Inc. All rights reserved.
13. To run the script, select Scripts > Run Current Script.

The script should do the following:

- Add another copy of the gait model so you can see the two models side-by-side in the View window.
- Add the normal and crouch motion files to the models.
- In the Plotter window, plot the length of the hamstring during a normal gait cycle.
- In the same Plotter window, plot the length of the hamstring during a crouch gait cycle.

14. Study the graphs in the Plotter window.

- What do the graphs tell us?
- How is this useful for the patient’s orthopedic surgeon?

15. Switch back to the OpenSim main window and click the View tab. You should see the two models side-by-side, as shown below.

![Figure 5. Normal and Crouch Models](image)

16. Expand the Motions branch of each model in the Navigator.
17. To run the simulated gait cycle, double-click the `normal_gait` motion under the first `3DGaitModel2392` model in the Navigator window, then click the Play Forward button in the Motion menu bar.

![Figure 6. Motion Menu Bar]

Observe the movement of the model as it walks with a normal gait.

18. Similarly, select the `crouch4_gait` motion under the second `3DGaitModel2392` model, then click the Play Forward button. Observe the movement of the model as it walks with a crouch gait.

19. To run both models at the same time, hold down the Ctrl key, and select both motion’s names – make sure you select one motion from each of the two models.

20. Right-click on either motion name, then select Sync. Motions from the popup menu.

![Figure 7. Sync. Motions]

21. Click Play Forward to see both models move at the same time.

22. Close OpenSim and discard all the changes. Do not save the results or any changes you made to the files.

**Note:** Physicians and scientists use models and simulations to generate data all the time. The data helps them make informed treatment plans for their patients. Physicians work with physical and occupational therapists to design treatment plans for their patients, and will use gait analysis technology to check the progress of their patients during different stages of their therapy.

**Part 3: Using OpenSim for Wrist Analysis**
In this section of the lesson, you will use OpenSim to study the musculoskeletal model of a wrist and hand. When engineers design products, including toys, they make sure that the product meets the consumer’s needs. For your therapeutic toy design, make sure to take the patient’s grasp into consideration as you choose your toy and brainstorm design ideas.

23. Launch the OpenSim application on your computer.

24. Copy the WristModel folder as instructed by your teacher and paste it into your documents folder. You will use your copy of the folder in this activity.

25. Select File > Open Model… and browse for the copy of the WristModel folder that you added to your documents folder in the previous step.

26. In the WristModel folder, select the model file wrist.osim. The model will load and display the wrist in the View window.

27. Using the left mouse button, right mouse button, and the arrow keys, manipulate the view of the model so you can see it as shown in the figure above.

28. Click the Coordinates tab.
29. Use the sliders to change the values of the coordinates and observe what happens in the View window. To reset to the original pose, click Poses and select Default.

30. Observe the deviation and flexion of the wrist and the flexion of the thumb and fingers. These are affected the most in patients with cerebral palsy. Patients experience difficulty flexing their thumb, fingers, and wrist, which in turn affect their ability to grasp objects.

31. Watch the short video illustrating grasp simulations. Notice how the simulation generates data to study the length of certain tendons during the simulated grasps.

Conclusion

1. Explain the benefits of using OpenSim.

2. How does the Plotter tool in OpenSim help the user?

3. Choose a career of interest to you and describe a simulation that would benefit people doing work in that field.

4. Now that you have explored models for the human gait and the grasp, think about ways you can use your observations to enhance your toy design. This will depend on what type of therapeutic toy you are considering for the unit problem. Does it involve walking? Does it involve grasping?
Problem 3.2

Therapeutic Toy Design Challenge

Introduction

Watch the 3.2 Therapeutic Toy Design Challenge Introduction Video

Video: Therapeutic Toy Design Challenge

Refer to your downloadable resources for this video.

Ms. Melissa Etzler, an occupational therapist who works with children with cerebral palsy, needs your help to design a toy. She wants to use the toy during therapy with children who have physical, sensory, or cognitive challenges. Therapy can improve their ability to carry out everyday activities and interact with their environment in a comfortable way.

Materials

- Isometric graph paper
- Measurement tools (rulers and dial calipers)
- CAD application (SketchUp® Pro)
- Data analysis application (GeoGebra)
- Fabrication materials
  - 3D printer
  - 3D printer filament
  - Foam pipe insulation and other consumable prototyping materials from Activity 1.1 Foot Orthosis Instant Design Challenge
  - Miscellaneous recycled or reusable materials, such as cardboard (as needed to build a prototype)
Scissors and other tools as needed

Duct tape and other assembly materials as needed

Resources

Problem 3.2 Rubric
Problem Design Brief Template
Decision Matrix Template
Design Brief Reference Guide

Procedure

Following the design process, you will work with your design team to create a toy for Ms. Etzler to use for therapy with children with cerebral palsy. You will use your understanding of design tools, technology, and teamwork to communicate ideas and collaborate with your design team.

Your team must identify a design opportunity for which you will create a toy. You may choose to modify an existing toy you dissected and analyzed earlier in Project 1.4 Investigate the Inside or design a new toy. Your team's design must incorporate universal design—accessible and appropriate for use by all children, but must also specifically address the therapy needs of children with cerebral palsy.

Complete each step of the design process and document them in your Gateway Notebook. As your team designs your toy, describe each task that you perform during each step. Include ideas, sketches, photos, tables, graphs, models, and other artifacts to communicate your design and process. Remember that the design process is iterative and your team should review the work you complete in each stage to determine whether design changes are needed.
Part 1: Define the Problem

As a team, develop a Design Brief using the 3.2 Design Brief Template and Design Brief Reference Guide.

1. Identify and list the client, target consumer and an estimated age range, and designer(s).

2. Describe the problem as explained in the Introduction section above and the Therapeutic Toy Design Challenge Introduction video.

3. Describe the anticipated design that could address the needs of the stakeholders, including the client and target consumer.

4. To identify criteria and constraints that address a therapeutic need, research the impact of cerebral palsy on children. These might include helping children develop balance, motor or movement skills, or communication. Document your research findings and sources in your Gateway Notebook.
5. List the criteria and constraints suggested by your teacher and Ms. Etzler. Talk to people who know about cerebral palsy—a special education teacher, occupational therapist, physical therapist, doctors, or nurses. Add constraints your team finds to be important to the success of the design.

6. Be specific in your design brief, but try to keep it no longer than one page. You will have to prove that your toy meets the criteria. It is often difficult to prove success if the constraints are not defined well.

7. List deliverables you will be required to create, such as models, documentation, and a prototype.

**Part 2: Generate Concepts**

8. As a team, brainstorm design solution ideas that will solve the design problem.

9. Create a thumbnail sketch of your design and document your ideas in your Gateway Notebook.

10. Use the Decision Matrix Template to analyze each team member’s design idea and select the optimal design for your team to create.

**Part 3: Design a Solution**

11. In your Gateway Notebook, create a multiview sketch of each part of your team’s toy design solution. Depending on the number of parts required for your toy, divide the needed part sketches among team members.

12. Using a CAD application and your multiview sketches, develop solid models for your toy parts. Your team may choose to divide the 3D models required among team members.

13. Save your solid model files in the location your teacher designated for your team. The following is a recommended file name format: `TeamNumber_PartName`


**Part 4: Build and Test**

15. Using the design specifications from your models, build a prototype of your toy. Prototypes can be 3D-printed, constructed using materials from Activity 1.1 Foot Orthosis Instant Challenge, and/or created with additional materials found around your school or home.

16. Test your toy prototype among your team members and, if possible, with stakeholders, including children who best match your target age.

17. Record your prototype testing results in your Gateway Notebook. Document what worked and
what didn’t work well during your testing. Be sure to collect pictures or video that show your prototype in action.

Part 5: Evaluate the Solution

18. If your testing data includes numeric data, record and plot the data sets in GeoGebra and save the file for documentation.

19. As a team, discuss the prototype testing and collected results. Use the following questions to guide your team discussion:

   ○ Did your prototype function correctly during testing?
   ○ What worked and what could be improved? To compare your answers, it might help to make a chart or list.
   ○ What can you infer or state about all the data you collected from the prototype testing?

20. Using your analysis of the prototype testing results, create adjustments to your design that would improve its performance and function. You will likely need to revisit and rework previous steps in the design process.

21. Document your team’s design modifications and final solution, including sketches, solid model images, and photos, in your Gateway Notebook.

Part 6: Present the Solution

22. As a team, present your design ideas and process, prototype, and justification for the final design solution to your class and stakeholders. An effective presentation includes:

   ○ Participation from all team members.
   ○ Creative delivery of the information while staying on topic.
   ○ A relaxed and self-confident presenter.
   ○ Effective and appropriate use of body language, speaking voice, and eye contact.
   ○ Visual aids (including documentation of your team’s design solution) that provide information with limited text and complement the presentation.

Conclusion
1. What is the value of creating items using universal design concepts?

2. How can failure be powerful and helpful during the design process?

3. What types of ethical considerations did your design team address during the design challenge? These might include safety considerations or the appropriateness of the design for users.

**Trademark Attribution** SketchUp is a registered trademark of Trimble, Inc. The GeoGebra logo and software are property of the GeoGebra Group. All other brand names, product names, or trademarks belong to their respective holders.
## Problem 3.2 Therapeutic Toy Design Challenge Grading Rubric

<table>
<thead>
<tr>
<th>Element</th>
<th>5 Points</th>
<th>4 Points</th>
<th>3 Points</th>
<th>2 Points</th>
<th>1 Point</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Problem or Opportunity Identification</strong></td>
<td>The design brief is complete and accurately identifies stakeholders, criteria, and constraints. Related design research is documented with sources.</td>
<td>The design brief is complete with most components accurately identified. Related design research is documented with sources.</td>
<td>The design brief is mostly complete, but some components are inaccurately identified. Related design research is documented but missing citations for some sources.</td>
<td>The design brief is somewhat complete, but multiple components are inaccurately identified. Little or no related design research is documented or cited.</td>
<td>The design brief is incomplete and multiple components are inaccurately identified. Little or no related design research is documented or cited.</td>
</tr>
<tr>
<td><strong>Design Sketches</strong></td>
<td>Sketches are complete and annotated to show all important information. All designs are unique and are created in pencil.</td>
<td>Sketches are mostly complete but are missing important information, such as some dimensions. All designs are unique and are created in pencil.</td>
<td>Sketches include less than half of the necessary details, dimensions, and annotations. Designs are not unique. Sketches are not created in pencil.</td>
<td>Sketches are incomplete. Dimensions and annotations are inaccurate or incomplete. Sketches are not created in pencil.</td>
<td>Sketches are incomplete with multiple missing or inaccurate details or dimensions. Sketches are not created in pencil.</td>
</tr>
<tr>
<td><strong>Brainstorming and Decision Matrix</strong></td>
<td>Design ideas are documented as sketches and notes. A decision matrix is complete and each design idea is evaluated. The student can effectively justify the final decision using the matrix.</td>
<td>Design ideas are documented as sketches and notes. A decision matrix is mostly complete and each design idea is evaluated. The student can effectively justify the final decision using the matrix.</td>
<td>Some design ideas are documented as sketches or notes. A decision matrix is somewhat complete and each design idea is evaluated. The chosen design solution is not clearly justified using the matrix.</td>
<td>Few design ideas are documented as sketches or notes. A decision matrix is incomplete and only some design ideas are evaluated. The chosen design solution is not clearly justified using the matrix.</td>
<td>Little or no design ideas are documented as sketches or notes. A decision matrix is incomplete or missing. The chosen design solution is not clearly justified using the matrix.</td>
</tr>
<tr>
<td><strong>Solid Models</strong></td>
<td>Solid models are complete with accurate details and measurements based on</td>
<td>Solid models are mostly complete with few inaccurate details or measurements</td>
<td>Solid models are somewhat complete with some inaccurate details or measurements</td>
<td>Solid models are incomplete with some inaccurate details or measurements</td>
<td>Solid models are incomplete with multiple inaccurate details and measurements</td>
</tr>
<tr>
<td><strong>Prototype Construction</strong></td>
<td>Resources are used effectively to construct a functional prototype that accurately reflects design sketches and models.</td>
<td>Resources are used effectively to construct a functional prototype that closely reflects design sketches and models.</td>
<td>Resources are used effectively to construct a functional prototype, but the prototype reflects only some aspects of design sketches and models.</td>
<td>Resources are ineffectively used and the prototype is not completely functional. Many aspects of the prototype do not reflect design sketches and models.</td>
<td></td>
</tr>
<tr>
<td><strong>Design Testing and Modifications</strong></td>
<td>Design improvements are considered and made using detailed results and data from prototype testing with stakeholders.</td>
<td>Design improvements are considered or made using results and data from prototype testing with stakeholders.</td>
<td>Some design improvements are considered or made using some results and data from prototype testing with stakeholders.</td>
<td>Few design improvements are considered or made using little results and data from prototype testing with stakeholders.</td>
<td></td>
</tr>
<tr>
<td><strong>Present Solution</strong></td>
<td>The presenter effectively and creatively delivers information related to the team’s design solution with appropriate visual aids.</td>
<td>The presenter adequately and creatively delivers information related to the team’s design solution with appropriate visual aids.</td>
<td>The presenter delivers some information related to the team’s design solution with few appropriate visual aids.</td>
<td>The presenter inadequately delivers information related to the team’s design solution with inappropriate or no visual aids.</td>
<td></td>
</tr>
<tr>
<td><strong>Collaboration and Teamwork</strong></td>
<td>The student consistently communicates ideas effectively, respects varying opinions, engages in compromise, and completes tasks in a timely manner.</td>
<td>The student generally communicates ideas effectively, respects varying opinions, engages in compromise, and completes tasks in a timely manner.</td>
<td>The student often communicates ideas effectively, respects varying opinions, engages in compromise, and completes tasks in a timely manner.</td>
<td>The student rarely communicates ideas effectively, respects varying opinions, engages in compromise, or completes tasks in a timely manner.</td>
<td></td>
</tr>
</tbody>
</table>
Problem 3.2 Therapeutic Toy Design Brief

Client

Target Consumer

Ages:

Designer(s)

Problem Statement

Identify the design problem or opportunity and create a brief statement to summarize it.

Design Statement

Create a statement that briefly describes the optimal design idea that can address the problem or opportunity.

Criteria and Constraints

Identify and list criteria and constraints for the design problem or opportunity.

Deliverables

Use your Gateway Notebook to include a detailed description of the Design Process. Summarize your work during each step of the process. Include documentation (written work, sketches, CAD drawings, images) to support your design.
### Problem 3.2 Decision Matrix Template

<table>
<thead>
<tr>
<th>Design Ideas</th>
<th>Criteria and Constraints</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>2</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td></td>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Copyright © 2017 Project Lead The Way, Inc. All rights reserved.
Problem 3.2 Therapeutic Toy Design Brief

Client: Fine Office Furniture, Inc.

Target Consumer: Ages: Middle school aged

Problem Statement
A local office furniture manufacturing company throws away tens of thousands of scrap ¾” hardwood cubes that result from its furniture construction processes. The material is expensive, and the scrap represents a sizeable loss of profit.

Design Statement
Fine Office Furniture, Inc. would like to return value to its waste product by using it as the raw material for desktop novelty items that will be sold on the showroom floor. Design, build, test, document, and present a three-dimensional puzzle system that is made from the scrap hardwood cubes. The puzzle system must provide an appropriate degree of challenge to middle school students.

Criteria and Constraints
- The puzzle must be fabricated from twenty-seven ¾” hardwood cubes.
- The puzzle-system must contain exactly five puzzle parts.
- Each individual puzzle part must consist of at least four, but no more than six hardwood cubes that are permanently attached to each other.
- At least two puzzle parts must be made up of 5 hardwood cubes.
- No two puzzle parts can be the same.
- The five puzzle parts must assemble to form a 2 ¾” cube.
- Some puzzle parts should interlock
- The puzzle should require middle school students an average of _______ minutes/seconds to solve. (Fill in your target solution time.)

Deliverables
Use your Gateway Notebook, physical or digital, to include a detailed description of the Design Process. Summarize your work during each step of the process, include documentation (written work, sketches, CAD drawings, images, etc.) to support your discussion. Your documentation must include the following information located in the appropriate Design Process step:
- Title page (Activity 2.1 Part 1)

Use the explanations shown to guide you to create your own Design
**Brief.**

**Client:** A person, company, organization, or group that requires the talents of an engineer or designer to develop a solution.

**Target Consumer:** People who will use the design.

**Designer:** The creative person who is designing a solution to the problem or opportunity.

**Problem Statement:** A clear and concise identification and description of the design problem or opportunity.

**Design Statement:** Challenging statement that describes the anticipated design to address the needs of stakeholders.

**Criteria:** A list of needs and design requirements that describe what the design solution must do to meet the needs of stakeholders.

**Constraint:** A list of specifications and design requirements that define parameters or boundaries the design solution must address. These might include time constraints, budget, codes, safety, or physical attributes (size, weight, color).

**Deliverables:** The final product or items that document the design solution and process presented to the client. Stakeholders use these deliverables to decide whether the solution addresses the design problem.
Remarks

Remark Title

Text of remark.
Glossary

accuracy

The extent to which a given measurement agrees with the standard value for that measurement.

annotation

A note of explanation, a dimension, or a comment added to text, diagrams, or models.

cerebral palsy (CP)

A condition that affects body movement and coordination. It is caused by brain injury or brain malformation that occurs before, during, or immediately after birth when an infant’s brain is still developing.

collaboration

Working together on a common purpose.

constraint

A limit or restriction to a design process. Constraints may be such things as appearance, funding, space, materials, and human capabilities.

criteria

Rules or requirements that a design must follow.

decision matrix

A tool for systematically ranking options using a set of criteria.

design process

A systematic problem-solving strategy that designers follow to come up with a solution to a problem.

dial caliper

A precision measuring device used to measure linear dimensions, thickness, or diameter.

dimension

Measurement in length, width, and depth.

documentation

A drawing, photo, video, or text artifact that contains information about a process or instructions for assembling, installing, operating, and servicing.
**isometric sketch**

A sketch in which an object’s parallel edges are drawn with parallel lines, typically at 30-degree angles to the horizontal baseline. There are no vanishing points and three sides of the object can be seen simultaneously.

**mechanical dissection**

Observing the operation of a device and describing its function and design specifications.

**modification**

A change or improvement designed to produce optimal accuracy and function.

**multiview sketch**

A sketch typically including three primary views of an object that are drawn using orthographic projections. The top, front, and right primary views of the object are projected onto a drawing plane perpendicular to each view. An isometric sketch of the object is often included.

**observation**

A remark, statement, or comment based on something one has seen, heard, or noticed.

**occupational therapy**

A treatment that focuses on helping people with a physical, sensory, or cognitive disability to improve function and be as independent as possible in all areas of their lives.

**optimal**

Describes a design, process, or system that is as effective or functional as possible within the given criteria and constraints.

**orthographic projection**

A method of representing views of a three-dimensional object by projecting the visible faces in each view on a two-dimensional plane.

**perspective sketch**

A type of pictorial drawing in which vanishing points are used to provide the depth and distortion that is seen with the human eye.

**precision**

The degree to which the correctness of a quantity is expressed.

**prototype**

A working model used to test a design concept by making observations and necessary adjustments.

**solution**
The answer to a problem or opportunity.

**surface area**

The total area of the surface of a three-dimensional object.

**team norms**

Guidelines that are developed by a team regarding how they are to interact, communicate, and conduct themselves as part of the team.

**thumbnail sketch**

A preliminary visual of a possible idea for a design. Most thumbnail sketches are not full size and have little detail. Their purpose is to help quickly explore possible alternative designs.

**unit**

A specified amount of something measured. Units allow us to use standard measurements.

**volume**

The amount of space, measured in cubic units, that an object or substance fills.

**additive modeling**

A solid modeling design method where an object is created by adding volume to a smaller object.

**algorithm**

A sequence of steps used to accomplish a task.

**algorithmic thinking**

The process of using algorithms when creating a solution.

**analyze**

To examine methodically by separating into parts and studying their interrelations.

**box-and-whisker plot**

A graphic way to display the median, quartiles, and extremes of a data set on a number line to show the distribution of data.

**computational thinking**

A problem-solving process used across disciplines. It includes multiple skills, such as problem decomposition and algorithmic thinking.

**computer-aided design (CAD)**

A process that uses a computer to assist in designing something, such as a part, circuit, or building.
coordinate plane

A two-dimensional space formed by a horizontal number line, called the x-axis, and a vertical number line, called the y-axis.

design statement

A statement that briefly describes the design goals and needs of stakeholders.

feedback

A process in which a system regulates itself by monitoring its own output.

geometric primitive

The simplest two-dimensional or three-dimensional geometric shape.

iteration

Repeating a process to yield results successively closer to the goal.

line segment

A part of a line that extends between two points on that line.

lower-quartile median

The median of the lower half of a data set.

mathematical model

A method of representing a real-world situation using mathematical concepts in order to understand and predict future behavior.

mean

The sum of the terms in a data set divided by the number of terms in the data set.

median

The middle number in a data set when the numbers are arranged in value order.

model

An accurate representation of an object or phenomenon. Models can be visual, physical, mathematical, or computational and are often used in the development of scientific theories or the engineering of artifacts.

ordered pair

A pair of numbers that define the location of a point on the plane. The first number in the ordered pair is the x coordinate, and the second number is the y coordinate.

perpendicular lines
Lines that meet at a 90-degree angle.

**polygon**

A closed geometric figure in a plane formed by connecting line segments endpoint to endpoint, with each segment intersecting exactly two others. Polygons are classified by the number of sides they have, so a triangle has three sides, a quadrilateral has four sides, and a pentagon has five sides.

**problem decomposition**

The process of breaking down a complex problem into smaller, more manageable problems.

**problem statement**

A clear and concise identification and description of the design problem or opportunity.

**section view**

A view of an object’s internal features and dimensions that allows designers to inspect the inside of solid models.

**solid modeling**

The process of creating a solid model or 3D object using a modeling and design application on a computer.

**subtractive modeling**

A solid modeling design method where an object is created by subtracting volume from a larger object.

**three-dimensional**

Having the dimensions of height, width, and depth.

**tree diagram**

A mathematical model used to help identify all possible outcomes in a real world situation.

**two-dimensional**

Having the dimensions of length and width.

**upper-quartile median**

The median of the upper half of a data set.

**vertices**

Plural of vertex. A vertex is the point where two or more sides (or edges) of a shape meet.

**cognitive**

Having to do with mental activities such as thinking, understanding, using language, and
remembering.

**computational solution**

A solution to a need or problem that is obtained using a computer to process information.

**computer model**

A representation of an object or a system that is developed using a computer program.

**gait**

A person’s manner of walking.

**hamstring**

The muscle at the back of a person’s upper leg.

**incremental progress**

Progress that is made slowly but steadily over time.

**musculoskeletal**

Having to do with muscles and bones.

**orthopedic**

The branch of medicine that deals with the prevention and correction of injuries or disorders of the skeletal system and associated muscles, joints, and ligaments.

**sensory**

Having to do with the basic senses used to collect information, such as sight, hearing, touch, smell, taste, and equilibrium.

**simulation**

A computer program that uses computer models to represent the behavior of a real-world system under different circumstances. A simulation produces numerical data that represent the change in the system’s state over time. This data can then be analyzed to better understand the model.

**stakeholder**

A person or group of people who share an invested interest in a project. These might include a client and target consumer of a design brief.

**therapy**

A process for physically or mentally improving a person’s quality of life and their ability to perform daily tasks.

**universal design**
The design of products or environments that can be used by all people without the need for adaptation or modifications.